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General Information 
 

Welcome 
 

Welcome to the Scia Engineer 15 AISC Steel Frame Tutorial. Scia Engineer is a design program in Windows with a broad application 

field: from checking/designing simple frames to the advanced design of complex projects in steel, concrete, cold formed steel  and a 
variety of other materials. 

The software allows engineers to model 2D and 3D structures which include flat or curved plates and beam members (straight or curved) 

as well as other advanced 3D geometry.  The complete calculation and design process has been integrated into one program so that the 
input of geometry, input of calculation information (loads, combinations, and supports), linear and non-linear calculation, output of results, 
reinforcement design according to various codes and the generation of the calculation documentation are all c ompleted in the same 

software. 

Scia Engineer is available in three different editions all which require a license to operate: 

- Concept 

- Professional 

- Expert 

License version  

A licensed version of Scia Engineer is secured with either a ‘dongle’, which you apply to the USB port of your computer or a software 

license on your company’s network. 

Scia Engineer is also modular and consists of various modules. The user chooses from the available modules and composes a cus tom 

design program, perfectly tuned to the desired needs of the company. 

In the general product overview of Scia Engineer you will find an overview of the different modules that are available.  

 

Demo version  

If the program doesn’t find a license on your computer, it will automatically start the demo version. The properties of the demo version 

are: 

- All projects can be inserted however projects created in a demo version cannot be opened in a licensed version. 

- The calculation is restricted to projects with 25 elements, 3 plates/shells and two load cases 

- The output contains a watermark “Unlicensed software” 

Scia Engineer Support 
If you need assistance with the software, you can contact the Scia Engineer support service in the following manners:  

By e-mail 

Send an e-mail to support@scia.net with a description of the problem and the concerning *.esa file, and mention the number of the 

version you are currently working with. 

By telephone 

 From USA: 443-542-0637 

Via the Scia Support website 

http://www.scia-online.com/en/online-support.html 

Website 
Link to Tutorials  

http://www.Scia-online.com > Support & Downloads > Downloads > input e-mail address > Scia Engineer > Scia Engineer Manuals 

& Tutorials 

Link to eLearning 

 http://www.scia-online.com > Support & Downloads > eLearning 

Link to Demo version 

http://www.Scia-online.com > Support & Downloads > Secured Downloads > input username and password > Service Packs > Scia 

Engineer > Setup – Scia Engineer 

mailto:support@scia.net
http://www.scia-online.com/en/online-support.html
http://www.scia-online.com/
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Introduction 
 

This tutorial describes the main functions of Scia Engineer 15, the input of design data and calculation of a 3D steel frame building.  

 

The tutorial will begin with the creation of a new project and the modelling of the steel frame structure. After the input of all frame geometry 
and loads, the structure will be calculated and the results will be viewed.  Next, the input of the slenderness and buckling parameters of 
the frame will be discussed, followed by the steel member calculations which contain the inclusion of unity checks and member 

optimization.  Next, a rigid steel connection will be modelled and displayed within the structure.  Lastly, the tutorial will discuss how to 
format an engineering report while properly displaying the calculation results. 

 

The figure below shows the computational model of the structure that will be completed through this tutorial (the units are in the Imperial 

system, e.g. kips, feet): 

 

 

 

  



 

 

Getting started 

Starting a project 

Starting the program 

Before you can start a project, you need to start the program first. 

 

1. Double-click on the Scia Engineer shortcut in the Windows Desktop. 

Or: 

2. If the shortcut is not installed, click [Start] and choose Programs > Scia Engineer 15> Scia Engineer 15. 

 

If the software cannot locate a license file, you will receive a dialogue box indicating that no license was found.  A second dialogue box 

will then list the restrictions of the demo version.  Click [OK] in both windows. 

 

For this Tutorial, you must start a new project. 

 

Starting a new project 

 

1. If the dialogue Open appears, click [Cancel]. 

2. Click the New icon  in the toolbar.  

 

 

 

In the Select New Project dialogue box, choose the Analysis environment by clicking on the corresponding icon. Confirm your choice 

by clicking [OK]. 

Now, the Project data dialogue box is opened.  Here, you can enter general data about the project. 
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3. In the Basic Data group, enter your preferred data.  The data you enter will be displayed on the output produced by Scia 

Engineer, e.g. in the document and on the drawings. 

 

4. Choose the Project level: Advanced and Model: One. 

5. Click on the rectangular button  below National Code to choose the default code for the project.  This code will 
determine the available materials, combination rules and code checks.  For the tutorial we will choose IBC (International 
Building Code). The window Codes in project is opened. 

 

- Click [Add]. 

- The dialogue box Available national codes are opened. 

- Select the USA flag and click [OK]. 

- You will return to the Codes in project dialogue and IBC is added. 

- Select the flag named IBC. 

- Select the Active code option and click [Close]. 

- You will return to the Project data window and IBC is the active code. 

 

6. Select Frame XYZ in the Structure field. 

The structure type (Frame XZ, Frame XYZ, Plate XY, General XYZ, etc.) will restrict the input possibilities during the 

calculation. 
 

7. In the Material group, select Steel.  Below the item Steel, a new item Material will appear. 

 

8. Choose A36 from the menu. 

 

9. Confirm your input with [OK]. 

 

10. On the Code Setup tab, you can see the specific codes that are used for the generation of loads and the design of steel, 

concrete and cold formed steel structures.  In addition to these codes, you can also choose the measurement system and 
formatting that will be used throughout the project.  



 

 

11. Click on Code Setup tab and click on the  button beside Code setup.  Now, the Format and measuring system 

dialogue box is opened. Choose Imperial format and click [OK]. 

 

 

 

 

 

Notes: 

On the Basic data tab, you can set a project level.  If you choose “standard”, the program will only show the most frequently used 

basic functions.  If you choose “advanced”, all basic functions will be shown.   

On the Functionality tab, you choose the options you need.  The non-selected functionalities will be filtered from the menus, thus 
simplifying the program and the analysis.  
On the Load tab, you will find the value for the acceleration of gravity and the applicable wind and snow loads that can be activated 

with the Climate loads functionality. 

. 
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Project management 
 

Save, Save as, Close and open 
 

Before entering the software to complete the frame construction, we will first discuss how to save a project, how to open an existing 

project and how to close a project. While completing the tutorial, the project can be saved at any time, that way you can leave the 

program at any time and resume the project from the save location later. 

 

Saving a project 

Click on   in the toolbar. 

 

If a project has not yet been saved, the dialog box Save as appears. Navigate to the location or the drive where you want to save your 

project in. Select the folder or subfolder in which you want to save the project and enter the project file name in File name field.  Once 

this is complete click on [Save] to save the project. 

If you press  twice, the project is automatically stored with the same name. If you choose File > Save as in the main menu, you 

can enter a new file name or save location for the project file.  

 

Closing a project 

 

To close a project, choose File > Close in the main menu. 

 

A dialog box appears asking if you want to save the project. Depending on your choice, the project is saved and the active dialog is 

closed. 

 

Opening a project 

Click on   to open an existing project. 

 

A list with Scia Engineer projects appears. Select the desired project and click [OK] (or double-click on the project to open it). 

  



 

 

Project Unit Setup 

Changing the units 
At the beginning of a new project, verify that the units used by Scia Engineer are compatible with your desired units. To check and 

modify the units: 

1. Click on Setup in the main menu and select Units. 

 

 
 

2. In the Units window you can view the units for different options and modify them to your desired unit system. 

 

 

 

Note: 
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It is possible to create a default template file that contains user preferences for desired units, scales and fonts.  A template file can be 

created and saved so that the user can load the desired template file before beginning a new project.  The creation and use of template 

files is not discussed in this tutorial.  

 

 



 

 

Geometry Input 
 

Input of the geometry 
When starting a new project, the specific geometry of the structure must be entered.  The structure can be entered directly, or it is 

possible to add geometry using instance templates with parametric blocks, DXF files, DWG files and other formats. 

Profiles 

When entering one or more 1D structural elements, a profile type is immediately assigned to each member.  By default, the act ive 
profile type is represented.  At any time it is possible to open the profile library to activate another profile type.  If you want to add a 

structural part before a profile type has been defined, the profile library will automatically be opened. 

 

Adding a profile 

3. Click on the Cross-Sections  icon in the toolbar. 
 

The Cross-Section manager is opened. If no profiles have been entered in the project, the New cross-section window will 
be automatically opened. 

 

                 

 

 

4. Click Profile library in the group Available groups. 

5. In the Available items of this group, you can choose a I-shaped profile   . Choose HP(lmp) 8X36 from the list. 

6. Click [Add] or  to add the profile to the project.  
 

 
7. Add W8X13 and W6X12 in a similar way. 

8. In the Available items for this group, you can choose an angle section   . Choose L(lmp) 3X3X1/4 from the list. 
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9. Click [Add] or  to add the profile to the project. 
 
 

10. Click [Close] in the New cross-section window, the Cross-Sections manager will appear. 
 
 

 
 

11. Click [Close] to close the Cross-Sections manager and to return to the project. 

Geometry 

Structure menu 

1. When a new project is started, the Structure menu is automatically opened in the Main window. If you want to modify the 
structure at a later time, you must double-click on Structure in the Main window. 
 



 

 

                                

 

 

2. In the Structure menu, you can choose different structural elements to enter the structure. 

 

To set up the structure, you must enter the first frame.  After doing so, the frame can be copied and the wind bracings and the horizontal 

beams will be entered. 

To enter the frame, you can simply add members such as columns and beams.  Scia Engineer however offers multiple Catalogue blocks, 

allowing for a smooth and simple input of the structure. 

Entering a frame using a Catalogue Block 

1. To enter a new frame, use the option Advanced input > Catalogue Blocks in the Structure menu. The Block select 
manager is opened. 

 

               

 

2. In the Available Groups group, choose a Frame 2D 

3. In the Available items of this group, you can choose the first frame   .  
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4. Confirm your choice with [OK]. The Geometry block window appears. 
 

               
 

5. Now, enter the frame dimensions: L = 39.5 ft, H1 = 16.5 ft and H2 = 3.5 ft 
 

6. In the pull-down menu, choose HP 8X36 for the Column and W8X13 for the Beam. 
 

7. Confirm your input with [OK]. The Catalogue block manager appears. 

 

         
 

 
 

8. Click [OK] to return to the project. 

 
9. The frame is positioned with the left column at the origin of the coordinate system.  To complete this, type the coordinates 0,0 

in the Command line and press <Enter> to confirm your input. 

 



 

 

                 

 

10. End the input with the <ESC> key. 

 

Notes: 

The properties of selected elements are shown and can be modified in the Properties window.  If no section has been defined in the 

project, the New cross-section window will automatically appear as soon as you try to enter a structural element (column, beam, 

brace, etc.).  At any time, you can end your active input by pressing either the <Esc> key either the right mouse button.   

 

To quickly visualize the entire structure, click Zoom All  in the toolbar. 

 

When entering coordinates using the command line, separate the desired coordinates using either a comma (,) or a space.  

 

After input of the first frame, it can be copied in order to obtain the structure for the entire hall.  Because the hall requires two additional 

steel frames, you can use the multiple copy option   to complete this task. 
 

 

 

 

 

Create multiple copies 

1. First select all entities to be copied.  Since it is necessary to copy all the beams and columns in the frame, you can use the 

Select All icon  . 
 

In this way, all beams and nodes are selected; this is represented in magenta: 
 

              



Tutorial Frame Steel 

14 

2. Now, you can use the Multiple copy option  (Modify > Multiple copy). 

 

     
 

3. In the Number of copies field, enter 2. 
 

4. To manually set the distance between the frames, deactivate the Define distance by cursor option.  Now, you can enter the 
distance 20ft as the y distance vector. 
 

5. Click [OK] to confirm your input. The frame has now been copied. 
 

6. Press <ESC> to finish the selection 

 

                           

After the frames have been entered, the connecting beams of the frames can be entered.  The start and end nodes of the beams are 

already known, i.e. the start and end nodes of the entered beams or columns.  Therefore, you do not have to enter the beams by 
means of coordinates; instead you can use the Cursor snap settings. 

 



 

 

Cursor snap settings 

1. Double-click on the Cursor snap settings icon  in the Command line or click on the button  at the 
lower right of the screen. The Cursor snap settings window is opened: 

 

2. Activate the options a) and b) to pick the midpoints and the end points of members in this project. 

 
3. Click [OK] to confirm. 

 

           

 

Now, you can enter the beams that connect the individual frames. 

 

 

 

 

Entering a beam 

1. To enter a new beam, you use the Beam option in the Structure menu. 

 

2. In the Cross Section field, choose the third section, W6X12.  
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3. Since the structure type Frame XYZ has two horizontal directions (i.e. X and Y), you must indicate the right direction for the 

horizontal beam in the Direct field.  Choose the Axis Y option. 
 

4. Set the beam length to 20ft. 
 

5. The default insertion point is set to Begin so that the left point determines the insertion position of the beam. 

 
6. Confirm your input with [OK]. 

 

7. Now, you can enter the beam by clicking with your mouse on the top node of the left-hand side column of the first frame: 
 

      



 

 

8. Enter the other beams of the roof in a similar way, by always clicking on the top node of a column. 
 

 
9. Press <ESC> to finish the input. 

 
10. Press <ESC> once more to finish the selection. 

 

 

Note: 

The Multiple copy option also allows for the automatic input of the beams connecting the frames. 

 

In the location between the first and second frame, we will add two more horizontal beams. To enter these beams, you could use the 

Beam option.  Scia Engineer however allows the user to copy these entities manually. 

 

Copying entities 

1. First indicate the entity that is to be copied. Since the beam we want to add is a horizontal beam, you can select any of the 
entered beams with the left mouse button.  The magenta color indicates that the beam is selected.  The properties of the 

beam are shown in the Properties window. 
 

2. Click with the right mouse button somewhere in the working environment.  The menu that lists the available possibilities for 

the selected entity appears: 
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3. In this menu, choose the option  

 
4. The program asks for the Start point of the member being copied.  Click with the left mouse button on the start node of the 

selected beam. 
 

      
 

5. Now, you must enter the End point, i.e. the position where the starting point should be copied.  As the new beams start in 

the middle of the columns, the midpoint of one of the columns of the first frame is chosen. 
 



 

 

    
 

As the midpoints option was already activated for the Snap settings, you can simply pick the center point of the column. 

 

6. After the first beam is copied, the copy command remains active so that you can also pick the midpoint of the second column 

of the first frame in order to enter a horizontal beam at that position. 
 

7. Press <ESC> to finish the input. 

 
8. Press <ESC> once more to finish the selection 

 

After the input of the horizontal beams, you can enter the required bracings.  

The bracings are not columns or horizontal beams; therefore, you must use the Member command in the Structure menu. 

 

Entering bracings 

1. To enter a new member, use the Member option in the Structure menu. 
 

    
 

2. In the Type field, choose Wall Bracing (0). This member type is only considered for the STRUCTURAL model and does not 
influence the calculation model or the results. 

 
3. In the CrossSection field, choose the steel angle section, L3X3X1/4 
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4. Confirm your input by selecting [OK]. 

 
5. Now, the bracings can be entered between the second and third frame of the structure.  To accomplish this, make sure to 

always click on the start and end nodes of the columns that you want to connect the braces with: 

 

 
6. Press <ESC> to finish the input. 

 
7. Press <ESC> once more to finish the selection 

 

The structure has now been completely modelled.  It is now possible to finish the structure by entering additional geometry, i.e. 

haunches, hinges and supports. 

 

 



 

 

 

 

 

 

 

 

 

Haunches 

In this project, haunches are entered on the roof beams, at the connecting positions with the columns. In Scia Engineer a haunch is 
defined by the following parameters: 

 

- A section with variable height 

 

- A length, over which the variable height must vary up to 0 

 

Entering Haunches 

1. To enter a new haunch, use the 1D member components > Haunch option in the Structure menu. 
 

2. As indicated, a haunch requires a variable profile.  Since this project does not yet contain any variable profiles, the New 

cross-section window automatically appears. 
 

3. In the Available groups menu, select the Haunch group. 

 

                 

 

4. In Available items of this group, choose a I + I var -profile  

5. Click [Add] or  to add the profile to the project. The Cross-Section window then appears where the member properties 
attributed to the variable section can be modified. 
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6. In the I sections field, change the section to W8X13 by clicking the   button behind the section type. 
 

7. When the correct I-section is selected, the variable height va [inch] can then be set as 6 inches. 
 

8. Confirm your input with [OK]. 
 

9. The New cross-section window reappears; click [Close] to close this window. 

 
10. The Cross-Section manager appears; click [OK] to close this window as well. 

 

11. Now, the Haunch on beam window is opened. 
 

 
 

12. In the Position field, choose Begin to position the haunch at the start node of the member. 
 

13. In the Coord. definition field, choose the option Abso to indicate that the length, over which the variable height must vary, 
can be entered in absolute units, i.e. in feet. 
 

14. When the Coord. Definition is adapted; the length of the haunch can be entered in the Length x [ft] field.  For this project, 
enter length 3.5ft. 
 



 

 

15. Confirm your input with [OK] 
 

16. The program will now ask you to indicate the members, on which a haunch must be entered.  Select the 6 roof beams with 
the left mouse button: 
 

      
 
 

17. Press <ESC> to finish the input. 
 

18. Press <ESC> once more to finish the selection 

 

As the previous image already shows the haunches are located in the correct locations on all 6 roof beams.  However, depending on 

how you input the roof beams initially and which nodes you chose as the Start nodes the haunches may be incorrectly positioned on one 
side of the hall.  To visualize this situation, you need to click the following buttons in the command line: 

 Show/hide surfaces  to show the surfaces of the sections. 

 Render geometry  to obtain a rendered view of the members. 

 

The position of the three haunches that were input incorrectly can be corrected in the Properties window. 
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Adapting Entities through the Properties window 

1. Select the 3 haunches to be adapted with the left mouse button. 
 

 
 

2. The Properties window shows the common properties of these 3 entities 

 

 
 
 

3. Here, you can see that the Position is set to Begin, in accordance with your input. 
 

4. Change this Position to End 



 

 

 

 
 
The modification is immediately reflected in the graphical window. 
 

5. Press <ESC> to finish the selection. 

 

            

In the command line, click Show/hide surfaces  and Render geometry  to deactivate both options and visualise the system 
lines of the members again. 
 

Note: 

A haunch entered into the structure overwrites the original section that was chosen for a specific beam.  For this project, this specifically 

means that the profile of the roof beam is replaced by the I + I var profile. If the haunch is removed, the I + I var profile will be maintained 
instead of the I-section of the roof profile. 
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Hinges 

In this project, the braces are connected with the other members in a hinged manner.  As the chosen structure type is Frame XYZ, the 

structural elements are connected to each other in a rigid manner.  Therefore, you must enter hinges manually on the structure. 

 

Entering hinges 

1. To enter hinges, use the Model data > Hinge on beam option in the Structure menu. 
 

                

 

2. The hinges are entered at both extremities of the diagonals; therefore, choose Both for the Position. 

 
3. To obtain a hinge, the rotation fiy is set to Free, the translations and the other rotations remain Rigid. In this way, the 

diagonals will be exclusively hinged in the planes of the sidewalls. 
 

4. Confirm your input with [OK]. 

 
5. The hinges are added when you click the diagonals with the left mouse button. 

 

6. Press <ESC> to finish the input. 
 

7. Press <ESC> once more to finish the selection. 



 

 

          

 

Note: 

Hinges are always defined with regard to the local coordinate system of a member. 

 
 
 

 
 
 

 
 
 

 
 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

 
 

 
Supports 

The geometry input of the structure will be completed by adding supports to the structure.  The column bases of the structure will be 
modelled as hinged supports. 

 

Before adding the supports, you first must select the nodes that the hinged supports will be added to.  You can select these nodes 

manually, one by one, or Scia Engineer offers a simple method to select entities with a common property. 
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Selecting elements per property 

1. To select all column bases, select one of the lower nodes, by drawing a frame from the left to the right with the mouse.  
 

 
 

2. The Properties window shows the properties of this node: 

 

 
 

 
3. Now, choose the property to be used for the selection of the entities.  For this project, you want to select all lower nodes.  

The common property of these nodes is their coordinate in the global Z direction.  To accomplish this, click with the left 

mouse button on the Coord Z (ft) property to select the field of this property. 
 
 



 

 

 
 

4. Choose the Select elements by property  option. The program will search for all entities within the structure that have 
the same property.  In this example, the program will select all nodes, for which the Coord Z (ft) property corresponds to 0 ft. 

 

Upon completion of the previous step, all column bases are selected.  It is now possible for  supports to be added to these nodes. 

 

Entering supports 

1. To enter supports, use the Model data > Support > in node option in the Structure menu. 
 

 

 

 

 

 

 

 

 

 
 
 

 
 
 

 
 
 

 
 
 

 
 
 

2. To create a hinge, select the translations Rigid and all rotations Free. 
 

3. Confirm your input with [OK]. The supports are automatically attributed to the selected nodes. 

 
4. Press <ESC> to finish the selection. 
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Notes: 

If you draw the box from the left-hand side to the right-hand side, only entities, which are completely in the rectangle, will be selected.  If 

you draw the rectangle from the right-hand side to the left-hand side, the entities, which are completely in the rectangle, as well as the 
entities that intersect with the rectangle will be selected. 

 

The Command line includes a number of predefined supports.  For this project, you could have used the hinged support   icon. 

Similar to the selection of supports, you could have used the Select elements by property  option to select all diagonals, where 

hinges were to be entered.  The determinant property here would have been the Section attributed to the braces. 

 

 

 



 

 

Check Structure data 
After input of the geometry, the input can be checked for errors by means of the option Check Structure data. With this tool, the 

geometry is checked for duplicate nodes, zero beams, duplicate beams, duplicate hinges and duplicate supports.  

 

Checking the structure 

1. Double-click on the Check Structure data option in the Structure Menu or click on the  icon in the toolbar. 
 

2. The Structure data check window appears, listing the different available checks. 
 

                        

 

3. Click [Check] to perform the checks. 

 
4. The Data Check Report window appears, indicating that no problems were found. 

 

                             

 

5. Close the check by clicking [OK]. 

Connecting entities 

In the case of this structure, the columns and roof girders share a common node. The end node of the column for instance is the start 
node of the roof girder. Therefore the girder is automatically connected to the column. 
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The two beams connecting at the middle of the columns are not ending in nodes. The end nodes of the beams are located inside the 

column and therefore are not yet connected to the columns. In this paragraph, we will explain how to connect the beams to each other 

at points other than typical end or start nodes. 

To display the names of the members and nodes, you can activate the labels by means of the buttons in the Command line. 

 

Activating node labels 

 Node labels are activated by means of the   icon on top of the Command line. 

 

Activating Member labels 

 Member labels are activated by means of the  button on top of the Command line. 

 

 

When you select column B1 with the left mouse button, the properties are displayed in the Property Window: 



 

 

 

 

This window indicates that the start node is N1 and the end node N2. Node N20 is not part of the column. To connect beam B20 to the 

columns, use the Connect members/nodes option. 

 

Connecting entities 

1. Press <ESC> or click the Cancel selection  icon to deactivate any selection of entities. 
 

2. Double-click on the Model data > Connect members/nodes option in the Structure menu or click the  icon in the 
toolbar. 
 

3. A dialogue box asks if all nodes entities are to be connected: 
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4. Click <Yes>. 

 

5. The Setup for connection of structural entities dialogue box now appears. 

 

                 

 

 

6. Confirm the settings by clicking <OK>. 

 

7. A window appears to indicate the number of connected nodes: 
 

                  

 

8. Connected nodes are represented in the graphical screen by means of double red lines: 

 

When you select for instance beam B20, the Properties window will show that node N20 connects the girder with column B1 and that 

node N21 connects the girder with column B8 

 

 



 

 

 

            

 

Note: 

If a possible active selection is not deactivated when the Connect members/nodes command is used, the program will only search the 

nodes to be connected in this selection and not in the entire project.  

It is also possible to perform the two previous operations at once. To do this you have to check the option Check (merge duplicate 

nodes, erase invalid entities) in the Setup for connection of structural entities dialogue box. 

 

9. Click [Close] below the Structure menu. 
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Graphic representation of the structure 
 

Edit view 

 

Within Scia Engineer there are several possibilities to edit the graphic representation of the construction. Below you will find the most 

important options: 

 

 Edit the view point on the Construction 
 

 Set a view direction 
 

 Use the magnifier 
 

 Edit view parameters through the menu View parameters 

 

Editing the view point on the construction 

 

One of the methods for editing the view point of the structure is through the three wheels in the bottom right of the graphic window; two 

are horizontal and one is vertical. With these wheels you can zoom in on the construction or turn it.  

 

1. To zoom in on the construction or to turn the structure, click on the appropriate wheel (the cursor will change into a hand), 

keep the left mouse button pressed and move the wheel 
 
OR 

 
Set the view point by combining the buttons and mouse.  

 

2. Press CTRL + right mouse button at the same time and move the mouse to turn the construction. 

 

3. Press SHIFT + right mouse button at the same time and move the mouse move the construction. 

 

4. Press CTRL + SHIFT + right mouse button at the same time and move the mouse to zoom in or out on the construction. 

 

Note: 

If the structure is being turned while a node is selected, the structure will turn around the selected node. 

 

Setting a view direction with regard to the global coordinate system 

1. Click on the button View in direction- X  for a view the structure in the X-direction. 

 

2. Click on the button View in direction- Y  for a view the structure in the Y-direction. 

 

3. Click on the button View in direction- Z  for a view the structure in the Z-direction. 

 

The magnifier 

 

- Use  to enlarge the view size. 
 

- Use  to decrease the view size. 
 



 

 

- Use  to zoom in on a window. 

 

- Use  to view the whole structure. 
 

- Use  to zoom in on the selection. 
 

Editing view parameters through the menu View parameters 

 

1. Click in the graphic window on the right mouse button. The following shortcut menu appears: 

 

                            

 

Note: 

If an element was selected previously, you can define a setting that only applies to the selected elements. (An adapted shortcut menu 

appears). 

 

 

2. Choose the option Set view parameters for all. The window View parameter setting appears. The menu consists of 
various tabs. You can set the view parameters for all entities or just for the selected entities. 

View parameters – Entities 

 

 Through the tab entities the representation of the different entities can be adapted. 

 

 In the group Structure the following items are important for this project: 

 

- Style and color: You can display the colors per layer, material, cross-section or structural type. 
 

- Draw cross-section: With this the symbol of the cross-section is displayed on every member. 

 
- Local axes: With this the local axes of the elements are activated. 
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View parameters – Labels and description 

 

Through the tab Labels, the labels of different entities can be displayed. In the group Members the following items can be displayed as 

a label on the structure: 

 

- Name: Show the name of the cross-sections in the label. 

 

- Cross-section type: Show the cross-section type in the label. 

 

- Length: show the length of the member in the label. 

 



 

 

                    

 

View parameters – shortcuts 

 

In the toolbar above the Command line, several frequently used options are grouped among which: 

 

- Show/hide surfaces  to show the surfaces of the cross-sections. 

- Render geometry to view the rendered members in the structure. 

 

- Show/hide supports  to show supports and hinges. 

 

- Show/hide load to show the load case. 
 

- Show/hide other model data   to show other model data (like hinges, internal nodes, etc.) 

 

- Show/hide node labels  to view the label of the nodes. 

 

- Show/hide member labels  to view the label of members. 
. 

- Set load case for view  to edit the active load case. 
 

- Fast adjustment of view parameters on the whole construction  to quickly access the options from the View 
Parameters menu. 
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After rendering the following structure is obtained:  

 

 

 



 

 

Loads and combinations 

Load Cases and Load Groups 
Each load that is inserted into the project and added to the structure is attributed to a load case.  A particular load case can contain 

many different load types. 

Each load can is attributed properties which will determine the proper generation of load combinations.  In addition, a specific load case 

will carry a specific action which can be set as permanent or variable. 

In the case of variable load cases, each variable load has its own associated load group.  The group contains information about the 

category of the load (service load, wind, snow, etc.) and its appearance (default, together, exclusive).  In an exclusive group, the 
different loads attributed to the group cannot act together in a normal combination.  Default combinations, on the other hand, will allow 

for simultaneous action of the loads in the same group within the load combination generator.  

The way in which load cases are defined, is critical for the load combinations created by the generator.  We recommend that you 

thoroughly read the chapter about loads and combinations in the reference manual found in the Help menu. 

In this particular project, three load cases are entered: 

 

- LC1: Permanent Load Case: Self weight of the steel members 

- LC2: Permanent Load Case: Weight on the Roof (Roof Dead) 

- LC3: Variable Load Case: Wind load on the Frame (Columns) 

 

Defining a Self Weight Load Case 

1. Double-click on in the Main window. 

 
2. Before you can define loads, you first must enter load cases.  Since this project does not contain any load cases yet, the 

Load Cases Manager will automatically appear. 

 
3. By default, load case LC1 is created.  This load is a permanent load of the Self Weight load type.  The self weight of the 

structure is automatically calculated depending on the length and type of steel cross sections entered. 

 
4. In the Description field, you can describe the content of this load case.  For this project, enter the description “Self Weight”. 

                
 
 
Defining a Permanent Load Case 

1. Click  or  to create a second load case. 
 

2. Enter the description “Roof Dead”. 
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3. As this is a permanent load, change the Action type to Permanent. 

 
4. Verify that both LC1 – Self Weight and LC2 – Superimposed Dead are in the LG1 LoadGroup. 

  

 

Defining a Variable Load Case 

 

5. Click  or  to create a second load case. 

 
6. Enter the description “Wind”. 

 
7. As this is a variable load, change the Action type to Variable. 

 

8. The Load Group LG2 is automatically created. Click  to display the properties of the Load Group. 
 

 

 

The IBC (LRFD) - load type determines the load factor that is attributed to the load cases in this load group.  In this project, choose W - 

Wind. 

 

9. Click [OK] to close the Load group manager and to return to the Load cases manager. 

 



 

 

               

 

10. Click [Close] to close the Load cases manager. 

 

Note:  

Load groups 

Each load is classified in a group.  These groups influence the combinations that are generated as well as the code-dependant factors 

to be applied.  The following logic is adopted throughout the software: 

Variable load cases that are independent from each other are associated to different variable groups.  For each group, you set the load 

category (see ASCE 7-05) and the combination factors from the AISC 360-05 or ASCE 7-05 are generated from the available load 
groups.  When a generated combination contains two load cases belonging to different groups, reduction factors will be applied for the 

transient loads.  

If the load is divisible, its different components are entered as individual load cases. As long as the load combination does not contain 

any variable load belonging to another group, no reduction factors will be applied.  The different load cases of a divisible load are 
therefore associated to one variable group.  

Load cases of the same type that may not act together, are put into one group, which is made exclusive, e.g. “Wind X” and “Wind -X” 

are associated to one exclusive group “Wind”.   

 

Loads 
After the input of the Load cases, the Loads menu will automatically appear: 

The first load case (LC1) includes the self weight of the steel members.  As can be seen in the Loads menu, self weight is 

automatically accounted for and no point or line loads need to be added to the frame.  The self weight is added to the structure based 
on the geometry and material properties of the sections. 
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Switching between load cases 

Activate LC2 by selecting this load case with the mouse pointer in the list box: 

                   

 

Once you have switched load cases, the roof dead loads can be entered as surface loads of 30lb/ft².  For this example, only the roof 

girders will be directly loaded. 

 

Entering the roof load as a surface load  

In order to enter a Surface load on beams, an option called Plane generator will be used. This plane generator can only be used in 
the current Workplane. Therefore, in order to input a roof load, the workplane will be changed to the roof. 

 

1. Go to Tools > UCS and select the option  
 

2. Select member B2.   The local z-axes of B2 (LCS) follows the inclination of the roof.  Thus, the workplane will now also follow 
the inclination of the roof 

 

3. Click on Plane generator in the Load menu. The Plane geometry dialogue appears 

 

 
 

4. The load Direction is Z and the System is the global coordinate system GCS. In this way, the load is acting vertically 

downwards. 



 

 

 
5. Change the Value to –0.3 k/ft2 

 
6. Click [OK] to close the plane geometry manager. 

 

7. In the Command Line, select the option New Rectangle. 

               

 

 

8. Click on node N2 (left node of the left roof plane) as the begin node and on node N13 (right node of the left roof plane) as the 

end node. 
 

 
 

9. Press <ESC> to finish the input. 
 

10. The load stays Magenta in color, which means it is still selected. Click on the combo-box in the Properties window > 

Loaded beams and change the option from All to Advanced. 
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11. In the Actions – window, select the option Update beams selection to indicate that only the girders and not the beams will 
be loaded directly by this surface load. 

 
12. Click on beams B2, B5 and B9. 

 

 
 
 

13. Press <ESC> once more to finish the selection. 
 

14. In the Actions-window, click on Refresh to generate/ recalculate the surface load to line loads on beams. 

 
15. The Recalculation of plane load to members – window appears. Hit the Calculate –button. 

 

                

 

You will see a refinement of the calculated line loads at the beginning of the girders. This refinement occurs automatically because of 

the presence of the haunches at the beginning on the roof girders. 

 

16. Click [OK] to confirme. 

 

17. You will now see the calculated line loads on the roof girders 



 

 

 

 

 

 

Continue the exercise by executing the same procedure on the right-sided roof plane. 
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Switching between load cases 

Activate LC2 by selecting this load case with the mouse pointer in the list box: 
 

          

 

Entering a linear load 

1. Click on Line Force - on beam in the Load Menu. The dialogue Line Force on beam appears. 
 

 
 

 
2. Change the Type to Force  

 

3. The load Direction is Z and the System is the local coordinate system LCS. The linear loads are acting in accordance with 
the local Z-axes of the members. 
 



 

 

4. Change the Value to –0.35 kip/ft. 
 

5. Confirm your input with [OK]. 
 

6. Select the members that the wind load will be applied to: the roof girders and the columns. 

 
7. Press <Esc> to finish the input. 

 

8. Press <Esc> once more to finish the selection. 

                 

Adapting a load 

1. Select the linear loads on the roof girders and the columns of the first and last frame by clicking the loads with the left mouse 
button. 
 

2. The common properties of the 8 individual loads are displayed in the Properties window. 
 

3. Change the Value from –0.35 kip/ft to –0.175 kip/ft in the Properties window. 

 
4. Confirm the modification with <ENTER>. 

 

5. Press <ESC> to finish the selection. 
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Click [Close] to quit the Loads menu and to return to the Main window. 

 

Note: 

The Command line includes a number of predefined loads: , which enable a fast and simple input of 
loads. 

Combinations 
After input of the load cases, the latter can be grouped in combinations. In this project, two linear combinations are created, one for the 

Ultimate Limit State (LRFD – Ultimate) and one for the Ultimate Serviceability State (LRFD – Service). 

 

Defining Combinations 

1. Double-click on  below  in the Main window. 

 
2. Since no combination has been entered yet, the window to create a new combination will automatically appear. 



 

 

 

 
 
 

3. The Type of the combination is changed to IBC (LRFD) - ultimate. With this combination type, Scia Engineer will 

automatically generate combinations in accordance with the complex composition rules of the ASCE. 
 

4. By means of the button [Add all], all load cases can be added to the combination. 

 
5. Confirm your input with [OK]. The Combination Manager is opened. 

 

6. Click  or  to create a second combination. 
 

7. Change the Type of the combination to IBC (LRFD) - serviceability. 
 

8. Confirm your input with [OK]. 
 

9. Click [Close] to close the Combination manager. 
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Calculation 

Linear Calculation 
If the calculation model is ready to be analyzed, it is then time to run the calculation of the frame and retrieve results.  

Executing the Linear Calculation 

1. Double-click on  below  in the Main window. 

 
2. The FE Analysis window appears. Click [OK] to start the calculation. 

 

 

 

3. After the calculation, a window announces that the calculation is finished and the maximum deformation and rotation for the 

normative load case is shown. Click [OK] to close this window. 

 

 



Tutorial Frame Steel 

54 

Results 

Viewing results 
After the calculation is executed, the results of the loading on the frame can be viewed. 

 

Viewing the Reaction Forces 

1. Double-click on  in the Main window. The Results menu appears. 

 
2. Below Supports, click Reactions. 

 

3. The options in the Property Window are configured in the following way: 
 
- The Selection field is set to All. 

 
- The Load type is set to Combinations and the Combination to LRFD - Ultimate. 

 

- The Values are wanted for Rz. 
 

- The Extreme field is changed to Node. 

 

 
 
 

4. The action Refresh has a red background, i.e. the graphical screen must be refreshed.  Click on the  button 
behind Refresh to display the results in the graphical screen in accordance with the set options.  The results for Rz displayed 

on the frame are in kip. 

 



 

 

       

 

5. To display these results in a table, the Preview action is used.  Click on the  behind Preview to open the Preview.  

 

 

 

Note:  

The preview appears between the Graphical Screen and the Command line. This screen can be maximized to display more data. 

Viewing internal forces on beam 

1. Click on Internal forces on beam below Beams 

 
2. The options in the Property Window are configured in the following way: 

 

- The Selection field is set to Current. 
 

- The Load type is set to Combinations and Combination to CO1 

 
- The Values are wanted for My. 
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- The Extreme field is changed to Global. 
 

 
 

 
3. Select the columns and the roof girders of the center (middle) frame with the left mouse button. 

 

4. Click on the  button behind Refresh to display the results in the graphical screen in accordance with the set 
options.  The results for My displayed on the frame are in kip-ft. 

 

 

 

To change the display of the results, the settings of the Graphical Screen can be adapted. 

 

Configuring the Graphical Screen  

1. In the Properties window, click the  icon behind Drawing Setup. The options for the graphical screen are opened. 



 

 

 
 

 
 

2. In the Representation field, choose Filled. 

 
3. The Angle of text is set to 0°. 

 

4. Click [OK] to confirm your input. 
 

5. In the Property Window, click the  button behind Refresh to display the results in the graphical screen in 

accordance with the set options.  Again the results for My displayed on the frame are in kip-ft. 
 

 
 

5. Then click [Close] to leave the Results Menu. 
 

6. Press <ESC> to cancel the selection. 

 

 

Note: 
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To change the font size of the displayed results, you can use the Setup > Fonts menu.  In this menu, the different sizes of the 

displayed labels can be changed as well as the sizes of any text associated with a specific layer. 



 

 

Code check 

 

The structural steel modules of Scia Engineer contain a number of powerful tools to perform the steel calculations in accordance with 

the chosen standard, which in this case is AISC 360-10.  Other specifications for steel design can also be used including AISC 360-05, 

AISC LRFD 2001 3rd Edition and AISC ASD 1989 9th Edition.  The specification can be changed by selecting Setup within the Steel 
menu of the Main Service Tree. 

The possibilities at a glance: 

- Input of advanced steel data 

 

- Simple addition, input and modification of member buckling data 
 

- Input of restraints against lateral-torsional buckling, web/flange stiffeners 

 
- Unity check of the profile section per AISC 360 

 

- Optimization of the profile section in relation to unity check 
 

- Input of frame connections 

 
- Input of diagonal connections 

 

- Automatic generation of sectional drawings 
 

- Automatic generation of assembly drawings and anchorage plans 
 

- Relative deformation check and web crippling data 
 

In this Tutorial, we will only review the basics of the steel structural analysis.  For more information regarding advanced steel 

calculations, we refer to the Advanced Training Curriculum. 

Before you can start the steel calculations, you first must check the buckling parameters of the members.  By means of the view 

parameters, the buckling lengths of the members can be displayed and modified.  
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Buckling parameters 

Displaying the system lengths 

1. Select the left column of the first frame, B1 with the left mouse button. 
 

2. Click the right mouse button at any arbitrary position in the workspace.  By doing this, a menu of the possible actions for the 
selected entity appears. 
 

3. In this menu, select the  option. The View parameter settings window appears. 
 

    
 

4. Activate the System lengths and Draw cross-section options to display the reference lengths and the section of the 
member. 

 
5. Activate the Local axes – Members 1D option to display the local coordinate system of the member. 

 

6. Confirm your input with [OK].  
 

7. Press <ESC> to cancel the selection. 

 



 

 

                            

The figure shows that system length Ly for buckling around the strong axis (y-y) is 16.5’ and Lz for buckling around the weak axis (z-z) 

8.25’ (2 times). The beam in the middle of the column therefore supports the column for buckling around the weak axis, i.e. for bending 
in the Y direction. 

To modify the buckling data of a member, use the option Buckling and relative lengths in the Property window of the selected 

beam. 
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Setting the Buckling Parameters 

1. Select both columns of the first frame with the left mouse button. 

 
2. The Properties window shows the common properties of both entities. The Buckling and relative lengths are set to 

Default. 

 

 

 

3. Click the  icon behind Buckling and relative lengths. The Buckling data window appears. 



 

 

 
 

 
 

This window shows that at the midpoint, the column is supported for buckling around the weak axis (zz) but not for buckling around the 

strong axis (yy). 

 

4. Click [Edit] to change the buckling data.  The Buckling and relative lengths window appears. 

 

 

 

5. On the Base Settings tab, several data points can be changed. 

 
- The Name field contains the name of the buckling parameter, in this case BC1. 
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- kyy and kzz: in these fields, you can indicate if the program must calculate the buckling factor around the axis regarded 
or if you prefer entering this factor manually.  A third option allows for a manual input of the buckling length.  The 

Support option can be used to determine the buckling factor in accordance with the applicable cross section and 
applicable material code. 
 

- Sway yy and Sway zz: in these fields, you can indicate if the member is braced or not in the direction regarded.  When 
you choose the Settings option, the default settings are used. 

 

Note: 

The default settings for the buckling parameters are displayed in Steel > Beams > Setup > Setup for check of steel members. For a 

steel calculation, the structure is by default unbraced for buckling around the strong axis and braced for buckling around the weak axis.  
Therefore, a frame is unbraced in plane and braced out of plane, taking the presence of wind bracings outside of the plane into 
account. 

 

 Buckling systems relation: in these fields, you can define the system length to be used for, amongst other things, torsional 
buckling and lateral-torsional buckling. 
 

 Relative deformations systems relation: in these fields, you can define the system length to be used for the relative 
deformations. 

 

6. On the Buckling data tab, you can edit each of the parameters in detail.  As the column consists of 2 components, i.e. 3 

positions are available for modification: (1) at the start, (2) in the middle at the horizontal beam and (3) at the end, where the 

roof girders are connected 
 
For instance, by modifying the Free option on position (2) for yy to Fixed, buckling of the column at the midpoint around the 

strong axis would be impacted. This would mean the relative length around this axes would also become half of the total 
length (= 8.25’).  For this Tutorial, the default options are maintained. 

 

 

 

 

 

 

 

 

                                                   

 

 

7. Click [OK] to close this window. 

 



 

 

8. The Buckling data window re-appears.  Click [Close] to close this window. 
 

 

 
 

9. The Properties window indicates that the buckling parameter BC1 is used for the columns of the first frame.  
 

10. Press <Esc> to cancel the selection. 

 

When the buckling parameters are set, you can continue with the steel check.  Before proceeding, deactivate the Member parameters 

and Local axes representation by means of the Fast adjustment of view flags on whole model  option. 
 

 
 

 

Steel code check 

Double-click on  in the Main window to open the Steel menu. 

Displaying the Slenderness and the Buckling Lengths 

1. Click the   icon in the Steel menu 

 

2. If this option is not available, you must restart the calculation using the Hidden calculation   icon in the Project toolbar. 
 

3. The options in the Properties window are configured in the following way: 

 
- The Selection field is set to Current.  
 

- The Values are wanted for Lam y, i.e. the slenderness around the yy axis.  
 
- The Extreme field is modified to No. 

 

4. Select column B1, the left column of the first frame. 
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5. In the Property Window, click the  button behind Refresh to display the results in the graphical screen in 

accordance with the set options. 

 

 

6. Change the Values field to Ly to display the reference length for buckling around the strong axis. 

 

7. In the Property Window, click the  button behind Refresh to display the new set values. 
 
  

   

 

As already indicated in the buckling parameters, the reference length is 16.5ft. 

 



 

 

8. Change the Values field to ly to display the buckling length for buckling around the strong axis. 

 

9. In the Property Window, click the  button behind Refresh to display the new set value. 

 

 

 

The buckling length is determined by multiplying reference length Ly by buckling factor ky. 

 

After viewing the steel data, you can perform the steel check for the columns. A unity check is carried out in accordance with AISC 360-

05.  This unity check includes both a capacity and a stability check. 

Steel Code Check 

1. Click  ULS Checks > Check LRFD in the Steel menu 

 
2. The options in the Properties window are configured in the following way: 

 

- The Selection field is set to All.  
 
- The Load type is set to Combinations and the Combination to LRFD - Ultimate.  

 
- The Filter is changed to Cross-Section.  
 

- For the Cross-Section, choose HP8X36 to ensure that only the results for the columns are displayed.  
 
- For the Values, choose a un. check.  

 
- The Extreme field is changed to Global. 
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3. In the Property Window, click the  button behind Refresh to display the results in the graphical screen in 

accordance with the set options. 

 

The graphical screen shows that the maximum of unity checks occurs for one of the columns in the middle frame. To better understand 

and analyze the cause of the problem, you can open the Preview with a detailed representation of the performed steel check. 

 

4. Before opening the preview, set the Output option in the Properties window to Detailed. Click the  icon behind 
Preview to open the Preview. 

 
 
 

 
 
 



 

 

Steel Design Check - Preview 
This report reveals that the column does not comply with the combined bending, axial force and shear force check  

according to the AISC-LRFD checks found in AISC 360-10.  As a result, the member does not satisfy the stability check and therefore a 

section with a larger inertia is required. 1
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After reviewing the results of the steel design check, Scia Engineer will allow the user to complete a simple and smooth optimization of 

the steel section.  The program will automatically propose a profile section, which complies with the unity check.  
 

Optimization of the Steel Section 
1. In the Properties window, click the  icon behind Autodesign. The settings of the Properties window are 

maintained, so that the HP8x36 can be optimised. 
 



 

 

The Optimization of the cross-section for the maximum loading conditions is as follows: 

 

     
 

2. This window once more displays the maximum unity check for HP8x36 as 2.662. 
 

3. Click the Search for Optimal button.  The program will search in the profile library for a profile complying with the unit check. 

 

 

 

It appears that HP12X74 complies with the requirements: maximum unit check 0.896. 

 

4. Confirm the optimization of the HP8x36 by clicking [OK]. 

Note: 

After an optimization, the project must be recalculated.  The change in cross-section ultimately modifies the total self weight of the 

structure as well as the structures stiffness.  This modification in stiffness will lead to a different distribution of the forces throughout the 

frame.  This means that after the optimization and recalculation of the structure, the profile chosen could possibly be overstr essed.  In 
that case, you must re-execute the optimization in order to find a cross-section that has a unity below 1.0. 

 

An optimization is always performed for a section, i.e. the optimized section is always attributed to all members with that particular section.  

In this Tutorial, the filter was already set to section.  If not, the program would automatically switch to this filter selection. 
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5. To quickly restart the calculation after an optimization, use the hidden calculation option.  Click on the Hidden Calculation  

icon in the Project toolbar. 
 

6. Click [Close] to quit the Steel menu 



 

 

Engineering Report 
In this final part of the tutorial, we will explain how the Engineering Report can be used to easily create a calculation package that 

includes input data, analysis results, design tables and graphical representations of the model.  In addition, external document items 
can be inserted into the Engineering Report within Scia Engineer so that the user can manage their entire calculation package in one 
integrated location. 

 

Formatting the Document 

1. Double-click in the Main Window or click  in the button bar. The Engineering Report appears 

in a separate window. 
 
The Engineering Report is divided into four main elements; the Navigator, the New Items list, the Document and the 

Properties palette. 
 

2. To add New items to the Navigator, which serves as the documents Table of Contents, select an item from the New Items 

list and click the [+] button or simply double click on the selected item.   
 

 
 

3. By means of this window, many different data types can be added to the document: 

 
- Open the Special items group and double click on Header/Footer and Table of Contents. 

- Open the Libraries group and double click on Materials and Cross Sections.  

- Open the Structure group and double click Members and Haunches. 

- Open the Results group and double click Internal forces on beam and Reactions.  

 

The items that were added to the document are displayed in the Navigator. Within the Navigator it is possible to drag the items with 

the mouse to change their order or even add the Special Item, Chapters to further organize and indent specific calculation elements. 
Additionally, it is possible to change the properties of any item within the list by selection the item and modifying the properties found in 

the Properties Palette. 

 
Additional Document Functions 

1. Add picture to document 
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- Directly via Right Click and Screen Shot of Scia Engineer workspace into Engineering Report or Live Picture into 
Engineering Report 

- To make a Live Picture 3D PDF capable, select picture and check “Export to PDF as 3D” 

2. Make changes to Live Pictures 

- Select Live Picture in Navigator and now the Picture Editing buttons become active. 

 

     

- Select “Edit Picture Properties” to change size, scale, view point, regeneration settings and result type. 

3. Adapt header template 

- Insert “Header/Footer” to Navigator 

- Modify Header information, add company logo and page numbers 

4. Adapt Style of Document 

- Via adding “Style” to Navigator from New Items list 

5. Modification of Tables 

- Select specific table in Navigator and click “Edit” button.          This enables the user to select and modify specific 

items in the table, change the table layout and also the size and spacing of the table items. 

6. Refresh of Engineering Report 

- After adaptations to data or (content of) tables: Red Exclamation Point means item regeneration needed. 

- Regenerate Selected Items  

- Regenerate Outdated Items (Pictures, Tables)  

7. Properties of the different components 

- After selection of a component in the Engineering report Navigator, its properties can be consulted and adapted in 
the Properties menu. 
 

Note: The Engineering Manager gives you the option to have multiple Engineering Reports in the same Scia file.  You can also have the 

Engineering Report open in the separate window while working in the Scia file.  Any changes made to the Scia file can then be updated 
by regenerating the outdated items (marked by a red exclamation point) in the Engineering Report. 

 



 

 

Epilogue 
 

In this tutorial, the basic functionalities of Scia Engineer for the input of a steel structure, including the steel member design check, 

member optimization and modelling of rigid connections were introduced by means of a steel frame building example. 

 

After reading the text and completing the example, the user should be able to model and calculate simple steel structures that include; 

steel members, surface loads, wind loads, load combinations, hinges, connections and the basic calculations shown in a document. 

 

For more detailed information about steel calculations, please refer to the Advanced Steel Training tutorials. 

 


